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Trademarks 

©2011 Ambir Technology, Inc. All rights are reserved.   

 

All trademarks and brand names mentioned in this publication are property 

of their respective owners. 

 

 

Liability 
While all efforts have been made to ensure the accuracy of all contents in 

this manual, we assume no liability for errors or omissions or by statements of 

any kind in this manual, whether such errors are omissions or statements 

resulting from negligence, accidents, or any other cause. The contents of 

this manual are subject to change without notice. We will not bear any 

legal liability if users fail to follow the operation instructions in this manual.  

 

 

Copyright 
The scanning of certain documents, e.g. checks, bank notes, I.D. cards, 

government bonds, or public documents, may be prohibited by law and/or 

subject to criminal prosecution. Please be responsible and respectful of 

intellectual property and copyright laws when scanning books, magazines, 

journals and other materials.  

 

 

Environmental Information 

Ambir Technology is committed to the environment. This 

product is designed and produced to achieve sustainable 

environmental improvement. We strive to produce products 

in compliance with global environmental standards. Please 

consult your local authorities for proper disposal. Our 

product packaging is recyclable.  

 

 

 

Screen Examples in This Manual 
The screen shots in this guide were made with Windows XP. If you are using 

Windows 7, Vista or 2000, your screen may look somewhat different but 

functionality is not affected.  
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INTRODUCTION 

Thank you for purchasing an Ambir scanner. We have designed this product 

to provide you with an effective tool to capture, manage, and archive 

documents of many types. We encourage you to read this important User 

Guide carefully.  

HOW TO USE THIS GUIDE 

This User Guide provides instructions and illustrations on how to install and 

operate your scanner. This guide assumes the user is familiar with Microsoft 

Windows 2000 Professional / XP / Vista / 7.  

The Introduction section of this manual describes the box contents and 

minimum system requirements to use this scanner. Before you install your 

scanner, check the box contents to make sure all parts are included. If any 

items are damaged or missing, please contact the point of purchase.  

Chapter I describes how to install scanner’s software and connect the 

scanner to your computer. Note: The scanner connects to your computer 

through the Universal Serial Bus (USB).  If your computer does not support USB 

technology, you will need to purchase a USB interface card to add USB 

capabilities to your computer, or buy and install USB connectors if your 

motherboard has USB capabilities.  This guide assumes that your computer is 

USB-ready and has a free USB port. 

Chapter II describes how to use your scanner. 

Chapter III describes how to maintain and clean your scanner. 

Chapter IV contains technical support information that can help you solve 

simple problems. 

Appendix A contains the specifications of the scanner you purchased. 

Appendix B contains our customer service, the limited warranty agreement 

and FCC statement concerning the product.
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GUIDE CONVENTIONS 

Bold — Represents commands or contents on your computer screen. 

ALL CAPS — Important note or first use of an important term in a chapter. 

Italic — Represents buttons on your scanner OR important notes. 

A Note about Icons 

This guide uses the following icons to point out information that deserves 

special attention. 

 

Warning 

 

A procedure that must be followed carefully 

to prevent injury or accidents. 

 

Attention 

 

Instructions that are important to remember 

and may prevent mistakes. 

 

Information 

Optional tips for your reference. 

SAFETY PRECAUTIONS 

 

Warning 

Before using this device, please read the 

following important information to eliminate 

or reduce any possibility of causing damage 

and personal injury. 

1. The product is for indoor use in dry locations.  Condensation may occur 

inside this device and cause malfunction if the following conditions are met: 

 when this device is moved directly from a cold to a warm location; 

 after a cold room is heated; 

 when this device is placed in a damp room. 

To avoid condensation: 

i. Seal this device in a plastic bag to allow it to adapt to room conditions. 

ii. Wait for 1-2 hours before removing this device from the bag. 

2. Use only the AC adapter and USB cable provided with the scanner. Use of 

other AC adapter and cables may lead to malfunction. 
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3. Keep the space around the AC adapter clear in case you need to quickly 

unplug the AC adapter during an emergency. 

4. Damaged wire could cause fire or electrical shock. Keep the power cord 

straight and avoid placement where it could lie twisted or bent.  

5. Unplug this device if you don’t need to use it for an extended period of time 

to avoid any risks of causing a fire.  

6. Do not attempt to disassemble the scanner. There is danger of electric 

shock. Opening your scanner will void your warranty.  

7. Be sure not to bump or knock the scanner glass as it is fragile and could 

break. 

8. Do not subject the scanner to excessive vibration. It may damage the 

internal components. 

MINIMUM SYSTEM REQUIREMENTS
1 

 PC with Intel Pentium® IV 2.0 GHz processor or compatible. (Pentium IV 3.0 

Ghz recommended) 

 1 GB RAM 

 Available USB port. (USB 2.0 recommended) 

 CD-ROM Drive or DVD-ROM Drive 

 800 MB Free Hard Disk Space (1GB or larger recommended) 

 High color graphic card (VGA or higher) 

 Operating System: Windows XP (Compatible), Windows 2000, Windows 

Vista, Windows 7 

 

 

Information 

Systems with Pentium® IV 3.0 GHz or higher 

processor (or its compatible), 1 GB RAM and 

1GB free hard disk space are recommended 

for optimal performance. 

                                                 
1  Higher requirements may be needed when scanning or editing large quantities of images.  

The system requirements stated are only a guideline. Generally, the better the computer 
(motherboard, processor, hard disk, RAM, video graphic card), the better the results. 
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BOX CONTENTS
2 

 
 

1. Scanner 

2. USB Cable 

3. AC Adapter 

4. Paper Chute (Automatic Document Feeder or ADF) 

5. Quick Guide 

6. Setup/Application CD-ROM 

7. Calibration Sheet  

8. Memo Label 

9. Cleansing Cloth 

10. Pad Module

                                                 
2  Save the box and packing materials in case you need to transport this scanner in the 

future.     
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SCANNER FEATURES 

 

1. PAPER CHUTE—Helps keep the paper in place.  Install the paper chute 

before using the scanner. 

2. PAPER WIDTH SLIDER—Adjusts the paper width slider for the paper size 

you are using. 

3. COVER OPEN LEVER—Opens the cover of the Automatic Document Feeder 

(ADF).  Pull it to open the ADF cover when you need to clear paper jam or 

clean the scanner. 

4. STACKER—Keeps the paper in place.  Extend it in case of longer paper. 

5. ADF (AUTOMATIC DOCUMENT FEEDER)—Automatically feeds a stack of 

documents for scanning. 

6. PAPER CHUTE EXTENSION—Extends to hold longer paper. 
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3. POWER SAVING BUTTON—Press and hold about one half-second to enter 

the standby mode (sleep mode).  You may press this button again to 

wake up the scanner from power saving. 

4. POWER / POWER SAVING LED—Indicates the scanner status.  

5. UP BUTTON—Press to move forward the scanning task number indicated 

in the function number display. 

6. DOWN BUTTON—Press to move backward the scanning task number 

indicated in the function number display. 

7. SCAN BUTTON—Press to perform a predefined scanning task selected by 

the up or down button. 

8. FUNCTION NUMBER DISPLAY—Indicates the number of the predefined 

scanning task selected by the up or down button. 

9. WARNING LED—Indicates the scanner error status. 
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14. USB PORT—Connects the scanner to a USB port on your computer by the 

included USB cable. 

15. POWER RECEPTOR—Connects the scanner to a standard AC power outlet 

by the included AC adapter. 

16. POWER SWITCH—Use this to turn the scanner ON or OFF. 

 

LED INDICATOR 

 

The Power/Power Saving LED and Warning LED indicate different scanner 

status.  

 

Warning LED 

Light  

Power / Power 

Saving LED 

Light  

 

Status 

Off White The scanner is turned on, ready to scan images. 

Off Orange The scanner is in standby mode (sleep mode). It 

will enter this mode if it is idle for 10 minutes. 

Red Blinking White  The ADF cover is opened. 

Blinking Red White  Paper jam. 

Blinking Red 

 

Off An internal component of the scanner may have 

malfunctioned.  

Off Off The scanner is off, either because the power is not 

turned on, or because the AC adapter is not 

properly plugged into an AC power outlet. 
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ULTRASONIC SENSOR  
 

When scanning a stack of documents using the ADF, the Ultrasonic Sensor 

detects and prevents paper jams by checking paper overlap.  If the Sensor 

detects 2 or more pages stuck together when being fed through the ADF, it 

halts scanning and triggers a message on your computer screen, letting you 

separate the sheets and continue scanning. 

To keep the Ultrasonic Sensor working properly, clean it lightly with a dry 

cloth. 

 

 

Information 

This function may or may not be available 

depending on the scanner model you 

purchased. 

 

 

 

 

Ultrasonic Sensor 
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CHAPTER I.  

INSTALLING THE SCANNER 

Before installing your scanner, please verify that you have all of the proper 

components.  A list of the package contents is provided in the “Box Contents” 

section on Page 4 of this guide.  

SOFTWARE INSTALLATION REQUIREMENTS 

Your scanner comes with the following software included: 

- AmbirScan ADF  

- OCR software (ABBYY FineReader 9.0 Sprint) 

- Document management software (NewSoft Presto! PageManager 9)  

- Contact management software (NewSoft Presto! BizCard) 

- Scanner driver 

All of these software applications use approximately 400 megabytes of hard 

disk space after they are installed into your computer.  To ensure ample room 

for the installation, as well as for scanning and saving images, a minimum of 1 

GB of hard disk space is recommended. 

This USB scanner can only operate under the Microsoft Windows XP / Vista / 

or Windows 7 operating systems. 

HARDWARE REQUIREMENTS  

This scanner connects to your computer through the Universal Serial Bus 

(USB) which supports HOT PLUG AND PLAY.  To determine whether your 

computer is USB-capable, you must check the rear of your PC to locate a USB 

jack that looks like the picture below. Some computers provide USB jacks in the 

front. If you are having trouble in locating a USB port on your computer, please 

refer to the hardware manual that came with your computer.  
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Upon examination, you should find one or two rectangular USB ports, which 

usually appear as shown below. 

 

            

If you don’t find such USB ports on your computer, then you need to 

purchase a certified USB interface card to add USB capabilities to your 

computer. 

INSTALLING AND SETTING UP THE SCANNER 

Please follow the step-by-step procedures described below to install the 

Ambir ImageScan Pro™ 940u scanner. 

 

 

Attention 

Choose the right location first! 

 Always place your scanner on a level, 

smooth and strong surface before 

proceeding with scanner setup or any 

scanning task. 

A tilted or uneven surface may cause 

paper-feeding errors, scanner damage 

or personal injury. 

 Avoid using the scanner in a dusty 

environment.  Dust particles and other 

foreign objects may damage the unit. 

 

USB Connector(s) 
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Step 1.  Install the Paper Chute 

1. Open the ADF cover by pulling the lever, and get the paper chute ready.  

 

2. Install the paper chute by aligning and inserting the tabs of the paper chute 

into their slots on the scanner. 

 

 

 

 

3. Close the ADF cover by pushing it back down until it snaps back into place. 

 

 

 

 

Cover open lever 

ADF cover 
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Step 2.  Connecting the Scanner to Your Computer 

 

 

 

Attention 

Please make sure the scanner is turned OFF 

before you plug or unplug the scanner 

power adapter. 

1. Plug the AC adapter into the scanner’s power receptor . 

2. Plug the other end of the AC adapter into a standard AC power outlet. 

3. Plug the square end of the included USB cable to the USB port  at the 

rear of the scanner. 

4. Plug the rectangular end of the USB cable to an available USB port on your 

computer. 

5. If you plan to connect your scanner to a USB hub3, make sure that the hub is 

connected to the USB port in your computer.  Next, connect the scanner to 

the USB hub. 

 

                                                 
3  The USB hub is not included with the scanner. 
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Step 3.  Installing the Software 

1. Switch on the scanner power from the rear of the scanner. 

2. If the USB components on your computer are functioning correctly, they will 

automatically detect the scanner causing the Add New Hardware Wizard or 

Found New Hardware Wizard to be launched. 

 

 

Information 

If your computer is off when the scanner is 

connected, the “Add New Hardware 

Wizard” message will not be displayed until 

the computer is on and Windows starts. 

3. For Windows XP: 

a. Insert the Setup/Application CD-ROM included with your scanner into 

your CD-ROM drive. 

b. Select Install the software automatically recommended and click the 

Next button. 

c. Click the Next button in the window that appears. Afterwards, please 

skip to step 7. 

4.  For Windows Vista: 

a. Select “Locate and install driver software (recommended)” when the 

“Found New Hardware” window is displayed. 

b. Click on the Continue button when the “User Account Control” dialog 

pops up. 

c. Insert the Setup/Application CD-ROM included with your scanner into 

your CD-ROM drive when the system prompts you “Insert the disc that 

came with your USB Scanner”, and click on the Next button. Afterwards, 

please skip to step 8. 

6. For Windows 7: 

When the Setup/Application CD is for one scanner model 

a.  Insert the Setup/Application CD-ROM, included with your scanner, into 

your CD-ROM drive. Click Run install.exe in the AutoPlay window. 

b.  Click on the Yes button if the User Account Control dialog pops up. If the 

pop-up wizard window appears click Next, and click Install this driver 

software anyway in the Windows Security window then click Finish in the 

wizard window. Afterwards, please skip to procedure 9. 

7. During the process of the installation, a message “Windows can’t verify the 

publisher of this driver software” might appear.  You may safely ignore it, 

and click on Install this driver software anyway to continue the installation.  

8. When the system completes the installation, click the Finish button. 
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9. Follow the on-screen instructions to install all software that your new scanner 

requires.   

10. After the software is installed, close all open applications and click the Finish 

button to restart your computer. 

 

 
Information 

If the scanner installation is not started and 

displayed automatically on the screen, 

click Start, select Run and type in D:\Install 

(where D: is the drive letter assigned to the 

CD-ROM drive of your computer.)  

Step 4.  Testing the Scanner 

The following describes how you can check if the scanner is properly 

functioning with your computer and the scanning software by performing your 

first scan with our bundled application NewSoft Presto! PageManager 9. Before 

testing your scanner, double-check to make sure that all cable connections are 

securely fastened. 

 

To test ADF scanning: 

1. Load a document headfirst and face down into the ADF with the text side 

facing the paper chute.  (For detailed instructions on loading paper into 

the ADF, please refer to the “Preparing Documents” section of this guide.) 

 

2. Click the Windows Start button to launch NewSoft Presto! PageManager 9. 

3. (If you have only one scanner connected with your computer, please skip 

to Step 4.)  

 If you have more than one scanner or other imaging device installed on 

your computer: Click Select Source from the File menu of Presto! 

PageManager 9 and then choose the Ambir ImageScan Pro ™ 940u 

scanner as the default scanning source. 
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4. Within Presto! PageManager 9, click Tools > Scan Settings > uncheck 

“Suppress TWAIN User Interface” > OK. Click File > Acquire Image Data.  

5. Select ADF (Front Side) as the Scan Type within the TWAIN window. 

6. Click the Scan button. 

7. The document in the ADF paper chute should be now loaded into the ADF 

and scanned. After this process, you should see a scanned image of the 

document on your screen. 

8.    Click Exit to exit the TWAIN window. 

INSTALLING ADDITIONAL SOFTWARE 

Your scanner is TWAIN-compliant and functions with virtually all available 

TWAIN compatible software.  If you purchase additional software to be used 

with your scanner, please make sure that it conforms to the TWAIN standard.
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CHAPTER II. SCANNING 

The AmbirScan ADF program seamlessly integrates the operation of your 

scanner with your computer and other peripherals. AmbirScan ADF provides a 

quick and convenient way to perform various scanning functions.  With 

AmbirScan ADF, you don't need to adjust settings every time you scan. Simply 

press any button on the scanner's front panel or click any scanning menu item 

of AmbirScan ADF on the screen. The scanner starts to scan your paper 

documents and transfer them to your assigned destination. The destination can 

be a printer, your E-mail program, files on your disk drives, an image-editing 

program, etc. 

Since all documents or images (whether text or pictures) acquired from the 

scanner are treated by your computer as images, most scanning will be done 

from an image-editing program where you can view, edit, save and output the 

scanned images.  A document management program to scan, share and 

organize images, NewSoft Presto! PageManager 9 has been bundled for your 

scanner on the included Setup/Application CD-ROM.  It will allow you to alter 

and correct any scanned images by using a variety of filters, tools and effects.  

Need to scan text documents and edit them in a word processor? This is the 

role of Optical Character Recognition (OCR) software. OCR software converts 

the image files that are created when scanning text documents into text files 

that can be viewed, edited and saved by word processors.  An OCR program, 

ABBYY Fine Reader Sprint 9 has also been bundled on the included 

Setup/Application CD-ROM.  In order to use the scanner in this way, install the 

included OCR software. 

Please refer to the online help of each program to guide you through any 

questions you may have while scanning within that program. 

This chapter describes three important steps of scanner operations.  Read 

them thoroughly and follow the instructions to ensure correct use and optimal 

scanner performance. 

Step 1.  Preparing Documents 

Step 2.  Placing Business Cards, Placing Plastic Cards 

Step 3.  Scanning Documents 
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PREPARING DOCUMENTS 

Proper document preparation prior to the scan can prevent paper feed 

errors and damages to the scanner. 

Checking Document Conditions 

Make sure the size and ream weight of your documents are acceptable by 

the scanner.  Refer to “Appendix A: Specifications” of this guide for more 

information. 

Scanning multiple documents in a batch from the ADF can increase your 

work efficiency and make large scanning tasks easier.  The ADF of this scanner 

accepts a variety of paper and stationery, such as: 

 Normal paper whose size and ream weight meet the requirements 

stated in “Appendix A: Specifications” of this guide. 

 Notched paper 

 Coated paper (such as brochures) 

 

 

Attention 

To prevent paper feeding errors and 

damages to the ADF unit, strictly follow the 

instructions below: 

 Remove all small objects e.g., paper 

clips, pins, staples or any other fasteners 

attached before loading the paper into 

the ADF. 

 Make sure the paper is completely flat 

with no creased or curled corners. 

 Avoid scanning documents with pencil 

lead and newspaper clippings as they 

will make the ADF exposure glass and 

the inner ADF dirty.  If you have to scan 

such paper, clean the scanner 

frequently (refer to Maintenance 

section of this guide for more 

information). 

 The paper for each batch scanned by 

ADF can be of the same or different 

weights.  However, make sure the length 

of each scan batch is the same. 
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However, don’t use the ADF to scan any of the following documents: 

 Paper lighter than 14 lb. (50 g/m2) or heavier than 28 lb. (105 g/m2) 

 Paper with clips or staples attached 

 Paper with inconsistent thickness, e.g., envelopes 

 Paper with wrinkles, curls, folds, or tears 

 Paper with an odd (non-rectangular) shape 

 Tracing paper 

 Carbon paper, pressure sensitive paper, carbonless paper 

 Items other than paper, e.g., cloth, metal foil. 

 

 

Attention 

 DO NOT use the ADF to scan 

photographs or valuable document 

originals; wrinkles or other damages can 

result if paper feeds improperly.  

 DO NOT place paper with wet ink or 

correction fluid into the ADF.  Wait 

enough time to allow to dry before 

scanning. 

Loosening Documents  

Before loading a stack of documents into the ADF, loosen them as follows: 

1. Fan the documents so that no two pages are sticking together. 

2. Hold the documents upside down with both hands, and then gently 

push them onto a flat surface to align the edges of all documents. 

   

This will allow documents being fed into the ADF one at a time and prevent 

paper-feeding errors. 

PLACING DOCUMENTS 

1. Load the documents, headfirst and face down, toward the center of the 

ADF paper chute and all the way into the ADF until touching the bottom.   
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 For single-sided scans, load the documents face down so that the side to 

be scanned faces towards the paper chute.   

 For double-sided scans, load the desired page order of documents face 

down so that the side to be scanned faces towards the paper chute.  If 

you wish to scan both sides of a single page, the page need only pass 

through the ADF once. Set the scan type to “Duplex” in the AmbirScan 

ADF interface.  

 

2. If you need to scan longer documents, pull out the paper chute 

extension and stacker to provide further support for the documents. 

 

 
 
 

3. Adjust the paper width slider for the paper size you are using.  The paper 

width slider should be gently touching both sides of the documents.   
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Attention 

 DO NOT load more than 100 sheets of 

paper (70 g/m2, 18 lb.) to the ADF. 

 Paper scanned from the ADF must be a 

minimum of 5.08 x 5.08 cm (2” x 2”, W x 

L). 

 Make sure there are no gaps between 

the document stack and the paper-

width slider; otherwise, the scanned 

images can be skewed. 

 Although the documents should be 

loaded firmly in place ensuring optimum 

scanning accuracy, they should never 

be wedged in so tightly that the process 

of feeding them through the scanner is 

strained. 

 Do not load additional paper into the 

ADF while the unit is feeding and 

scanning. 

PLACING BUSINESS CARDS 

1. Horizontally load the business cards, headfirst and face down, toward 

the center of the ADF and all the way into the ADF until touching the 

bottom.    

 For single-sided scans, load the business cards face down.   

 For double-sided scans, load the business cards in desired order. Use the 

desktop scanning interface to set mode to “duplex.” As long as the scan 

type is set to “duplex”, each card will need to pass through the scanner 

only once. 
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2. Adjust the paper width slider to the business card width.  The paper width 

slider should be gently touching both sides of the business cards.   

 

 

Attention 

 Make sure the business cards you wish 

to scan are horizontally loaded into the 

ADF. 

 Don’t load more than 30 business cards 

in one batch. 

PLACING PLASTIC CARDS 

The Ambir ImageScan Pro 940u is equipped to scan plastic cards. Plastic 

cards can be embossed credit cards, driver licenses, ID cards, insurance cards, 

Medicare cards or any membership cards.  Make sure to load the embossed 

face of the embossed card top first, face down into the scanner. 

1. Horizontally load the plastic card, top first and face down, toward the 

center of the ADF.    

 For single-sided scans, load the card face down.   

 For double-sided scans, load the card in desired order. 

 

2. Adjust the paper width slider to the card width.  The paper width slider 

should be gently touching both sides of the card.   

 

 

Attention 

 Make sure the plastic cards you wish to 

scan are horizontally loaded into the 

ADF.   

 Maximum thickness of each plastic card 

is 1.2 mm. 

 Load up to five (5) plastic cards per 

batch. 



25 
 

 

SCANNING DOCUMENTS 

There are three different ways to operate the scanner when scanning 

documents: 

1. By acquiring images from the scanner into a TWAIN-compliant 

application through our TWAIN software interface. 

2. By scanning from the buttons on the scanner front panel. 

3. By scanning from AmbirScan ADF Execute menu on the screen. 

The TWAIN interface and AmbirScan ADF software are automatically 

installed to your system along with the scanner driver. 

 

 

Attention 

Before you start scanning, check the 

following: 

 Your computer and scanner are both 

turned on. 

 

 The icon appears on the Windows 

system tray. 

 

 Paper is properly loaded into the ADF. 

 

Scanning via TWAIN Interface 

The TWAIN program is a very important piece of software that comes with 

your scanner.  This program acts as an interface between the scanner 

hardware and the image-editing software you are using to view and edit 

images. The TWAIN program allows you to adjust a number of settings to define 

the quality of the scanned image. 

The following describes how you may use our bundled application (NewSoft 

Presto! PageManager 9) to scan via TWAIN interface.  When you get familiar 

with the scanning, you may alternatively use other TWAIN compatible scanning 

program or image-editing application to do your scanning projects. 

 

Scan within NewSoft Presto! PageManager 9: 

1. Click the Windows Start button to launch Presto! PageManager 9. 
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Attention 

If you have more than one scanner or other 

imaging devices installed on your computer, 

you need to set this scanner as the default 

scanning source before you before you 

acquire image data within PageManager 9. 

1. From the File menu of PageManager 9, 

click Select Source. 

2. In the window that opens, choose Ambir 

ImageScan Pro 940u and then click the 

OK button to set this scanner as the 

default scanning source. 

 

 

2. Within Presto! PageManager 9, click        

 File > Scan Settings > uncheck “Suppress TWAIN User Interface” > OK. 

Click File > Acquire Image Data.  

3. In the TWAIN window that opens, select ADF (Front Side) as the Scan 

Type if you want to scan single-sided documents, or select ADF (Duplex) 

to scan double-sided documents. 

 

 

 

4. Adjust the scanning settings.  For ADF (Duplex) scan, you can tailor 

settings individually for front and rear sides of the documents.  Click the 
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Front Side button to adjust the scanning settings of the document's front 

side and then click Rear Side button to adjust the scanning settings of 

document's rear side.   

You can enable the function of Merge Pages only when you select ADF 

(Duplex) as Scan type and Automatic Size as Page Size to output the 

scan images of both front and rear sides in one image.  Enable the 

Merge Pages function to join front and rear images.  You can select 

Horizontally to generate both front and rear image data horizontally in a 

joined image (the rear image will be placed at the right side next to the 

front image), or make the selection of Vertically to generate both front 

and rear image data vertically in a joined image (the rear image will be 

placed below the front image). 

5. Begin the scanning process by loading one page of the document and 

click the Preview button.  The scanned image should appear in the 

Preview Window.  To define the margins and to crop out (remove) 

sections of the image you don’t want scanned, use the mouse to click 

and drag the corners or sides of the scan area borders.  Adjust the scan 

settings and click Preview again if the preview image doesn’t satisfy your 

needs. 

6. Load all pages of the document and click the Scan button. 

7. When the scan finishes, click the Exit button to close the TWAIN window.  

The scanned images are displayed in Presto! PageManager 9, and you 

may perform any image editing tasks. 

Click the Help button within the TWAIN window for more information about 

the settings. 
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Scanning from the Scanner’s Front Panel 

Using the Ambir ImageScan Pro™ 940u front buttons to control scanning is 

very easy and convenient once you set the front panel controls up.  The 

number of scanning tasks displayed on the scanner’s front panel is configured 

through AmbirScan ADF.  AmbirScan ADF offers you quick access to the most 

frequently-used scanning functions.  These are especially useful when you need 

to repeatedly scan with the same settings and send images to the same 

destination.  Before performing your first scan using the scanner’s front buttons, 

you should configure the button settings to your needs and preferences first. 

  

Scan from the Scanner Buttons 

1. Place the document or images onto the scanner. (Refer to the Loading 

Documents section of this User Guide for more information on how to 

place paper into the ADF properly.) 

2. Check current button settings by viewing AmbirScan ADF's “Button 

Configuration” window.  In this window are found the default settings for 

the buttons, which you can use as is, or you can change.  Also provided 

with the scanner is a sticker with factory defaults printed and blank 

space to record your own button configuration.   If needed, you may 

modify settings to meet your current needs. (Refer to “View Button 

Settings” and “Configure Button Settings” below for more information.) 

3. Press the UP or DOWN button to select the desired task number 1-9.  

4. Press the Scan button.  

The scanner starts to scan immediately and carry out the corresponding 

action according to settings you have set up in the Button Configuration 

window.  

 

Attention 

Place only text documents for OCR 

purposes. Do not scan a photo using the 

OCR button. 

 

Configure Button Settings 

Within the “Button Configuration” window, you can find a row of icons 

running through the left side of the window.  Each icon represents a scanning 

task, and the number underneath corresponds to the function number 

displayed on the scanner front panel.  Nine (9) frequently-used scanning tasks 

are pre-configured for your convenience to start scanning immediately.  You 

may, however, customize the settings of every nine tasks to best meet your 

needs and preferences.  Follow the steps described below: 
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1. Do one of the following to open the Button Configuration window: 

 Double-click the  icon in the Windows system tray. 

 Right-click the icon in the Windows system tray, and then 

choose Button Configuration… in the pop-up menu that opens. 

2. Select a task number by clicking on the icon. 

3. Select the desired function from the drop-down list of Button Template 

and adjust button settings. 

 

 

Information 

As an option, you may wish to write down 

the customized button number settings on 

the included memo label and place the 

label the scanner. 

Click the Help button within the Button Configuration window for more 

information about the settings. 

 

View Button Settings 

There are three ways to view the button settings: 

 Double-click the icon in the Windows system tray. 

 Right-click the icon in the Windows system tray, and then 

choose Button Configuration… in the pop-up menu that opens. 

 View your memo if you write down the customized button number 

settings on the memo label. 

 

Scanning from the On-screen AmbirScan ADF Execute Menu 

You may also use AmbirScan ADF's on-screen “Execute” menu to perform 

the same scanning tasks.  The AmbirScan ADF program provides a quick and 

convenient way to perform various scanning functions.  Follow the steps 

described below: 

1. Place the document or images onto the scanner. 

 

2. Check current button settings by viewing the memo label or the 

Button Configuration window.  If needed, you may also modify settings 

to meet your current needs.  
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3. Right-click the icon in the Windows system tray, and then choose 

Button Configuration… in the pop-up menu that opens.  

 

4. Click the desired button function item in the pop-up menu. 

 

The scanner starts to scan immediately and carry out the corresponding 

action according to settings you have set up in the Button Configuration 

window.
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CHAPTER III. 

CARE AND MAINTENANCE 

Your scanner is designed to be maintenance-free.  However, timely care 

and maintenance can keep your scanner working smoothly. 

Cleaning the Scanner 

Paper powder, dust, ink and toner from paper being scanned may make 

the inner ADF dirty, which leads to poor image quality or document-feeding 

errors.  How often to clean your scanner depends on the type of paper and 

number of pages being scanned over time. In business environments, monthly 

maintenance may be appropriate. For more information, visit 

http://www.ambir.com/care 

Perform the following procedures to clean the scanner surface and the ADF 

unit.  Gently wipe locations described below.  Do not rub too hard. 

 

Warning 

 Before cleaning the scanner, turn off 

the scanner and disconnect the 

scanner’s power cable and USB cable, 

and then wait a few minutes for the 

glass and/or the inner ADF to cool to 

room temperature. 

 Wash your hands with soap and water 

after cleaning the scanner. 

Cleaning Materials 

Have the following cleaning materials ready to clean the scanner: 

 soft, dry, lint-free cloth (or a cotton swab) 

 non-abrasive cleaner—Isopropyl alcohol (95%).  DO NOT use water. 

 Alternatively, you can use glass cleaner or neutral detergent for 

window cleaning to clean the scanner glass. 

 However, DO NOT use either of these to clean the ADF feed roller or 

pad module. 

Use of other cleaning materials could damage your scanner and void the 

warranty. 

http://www.ambir.com/care
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Cleaning the ADF 

1. Open the ADF cover by pulling the lever.  

 

2. Gently wipe the following areas with the cloth dampened with the 

cleaner.  Be careful NOT to scratch their surfaces. 

 

Clean Feed Roller: 

Wipe the Feed Roller from side to side and then rotate it.  Repeat this 

until its entire surface is cleaned. 

 

 

Clean Pad Module: 

Wipe the Pad Module from top to bottom (in the direction of arrow 

shown in below picture).  Be careful not to damage the pick springs of 

the pad.  

 

 

Cover open lever 

ADF cover 
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Clean ADF Glass:  

 

 

 

Attention 

Do not spray cleaner directly onto the 

scanner glass.  Excess liquid residue may fog 

the glass or damage the scanner. 

 

3. Wait for cleaned areas to dry completely. 

4. Close the ADF cover by pushing it back down until it snaps back into 

place.   
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REPLACING CONSUMABLES 

As a guideline, it is recommended to replace the pad module every 50,000 

scans (letter-sized, 70 g/m2 or 18 lb. weight), and it is recommended to replace 

the feed roller every 300,000 scans (letter-sized, 70 g/m2 or 18 lb. weight).  

Keeping track of how many scans you've made is easy.  The Counter Utility 

program automatically counts the number of sheets scanned by your scanner 

and how many times the consumables are used. From the Windows START 

menu, point to All Programs > Ambir ImageScan Pro 940u, and then click 

Counter Utility. Refer to the online help of Counter Utility to explorer more about 

Counter Utility. 

Replacing the Pad Module 

1. Open the ADF cover by pulling the cover open lever.  

 

2. Remove the pad module by pinching both sides of the pad module and 

pull it out. 

 

Cover open lever 

ADF cover 
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3. Install the new pad module by inserting the tabs on the module onto 

their slots on the scanner.   

 

4. Close the ADF cover by pushing it back down until it snaps back into 

place. 

 

Replacing the Feed Roller 

1. Open the ADF cover by pulling the cover open lever.  

 

Cover open lever 

ADF cover 
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2. Remove the paper chute by pinching both sides of the handles on the 

paper chute to remove it. 

 

3. Remove the feed roller by pinching both sides of the feed roller and pull 

it out. 
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4. Install the new feed roller by aligning and inserting the feed roller onto 

the roller assembly on the scanner. 
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5. Install the paper chute by aligning and inserting the tabs of the paper 

chute into their slots on the scanner.  

 

6. Close the ADF cover by pushing it back down until it snaps back into 

place. 

 



39 
 

 

CALIBRATING THE SCANNER 

Calibrate the scanner if colors appear in areas that should be white, or if 

colors of the scanned image and of the original vary a lot. Calibration allows 

you to adjust and compensate for variations that can occur in the optical 

component over time. 

The following describes how to calibrate the scanner: 

1. Your scanner came packaged with a special sheet with symbols printed 

on it called a Calibration Sheet.  The Calibration Sheet is marked with an 

arrow on either edge at both sides and is used specifically for Ambir 

ImageScan Pro 940u calibration.   

2. Insert the special Calibration Sheet into the ADF of the scanner, with an 

arrow pointing toward the scanner's front buttons. 

 

 

Attention 

Please insert the special calibration sheet 

included with the scanner.  As an option, you 

may also use any plain white sheet of letter 

(8.5” x 11”) -sized paper instead; however, 

the calibration effect may not be as precise 

as when the special calibration sheet is used. 

3. Click Start > All Programs > Ambir ImageScan Pro 940u > Calibration 

Wizard. 

4. Click Next from the Calibration Wizard that pops up and then click 

Calibrate Now.... 

5. Click on the Start button to begin the calibration process. 

6. The scanner pulls the calibration sheet through the scanner, which 

completes this scanner calibration.  After the calibration is complete, 

click OK and then click Finish. 
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The calibration is now done. The scanner should now show improved scanning 

accuracy in color and position on future scans. 

POWER SAVE 

To save power consumption, the scanner light source always automatically 

turns itself off after the scanning process is finished. If the scanner will not be 

used for a long period of time, you should shut down the scanner and then 

disconnect the power cable from the power outlet. Leaving the power cable 

plugged in to a power outlet will consume electricity even if you do not 

operate the scanner. 

 

 

Information 

 The scanner will enter the standby mode 

(sleep mode) after it is idle for 10 minutes. 

Simply press any scanner button on the 

scanner panel and the scanner will return 

back to the normal status. 

 From the Windows START menu, point to 

All Programs > Ambir ImageScan Pro 

940u, and then click Scanner Utility. Refer 

to the online help of Scanner Utility to 

explore more about standby mode. 
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CHAPTER IV. TROUBLESHOOTING 

If you encounter problems with your scanner, please review the installation 

and scanning instructions contained in this guide. 

Many common use issues can be resolved by referring to the information in 

this chapter, or by consulting the FAQ (Frequently Asked Questions). To read the 

FAQ, from the Windows START menu, point to All Programs > Ambir ImageScan 

Pro 940u, and then click FAQ. 

SCANNER CONNECTION 

The first step to take when troubleshooting connection problems with your 

scanner is to check all physical connections, including power cable and any 

USB cabling and connections.  The icon  located on the Windows system 

tray, indicates if the scanner software is properly launched and the scanner 

and computer are communicating with each other. 

 

Appearance Status 

 The program has been successfully launched and the 

scanner is connected with the computer, ready to scan 

images.  

 Either the scanner is not connected with the computer or 

the scanner power is not switched on. 

No Display The AmbirScan ADF application is closed.  The scanner 

may or may not be connected to the computer. 
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CLEARING PAPER JAMS 

If a paper jam in the ADF happens, please perform the following steps: 

1. Remove any unjammed documents still loaded into the ADF. 

2. Open the ADF cover by pulling the cover open lever. 

 

3. Gently but firmly pull the jammed documents out of the ADF.  Try to 

avoid creasing or wrinkling the documents. 

 

 

Attention 

Do not try to pull jammed or half-scanned 

documents out of the ADF without first 

opening the ADF cover.  Doing so may 

permanently damage the ADF. 

4. Close the ADF cover by pushing it back down until it snaps back into 

place.   

 

Cover open lever 

ADF cover 
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APPENDIX A: SPECIFICATIONS
4 

 

Ambir ImageScan Pro™ 930u  

Optical Resolution 600 dpi 

Max. Hardware Resolution 600 x 600 dpi 

Scan Modes 

Color: Input 48-bit; Output 24-bit 

Grayscale: Input 16-bit; Output 8-bit 

Black & White: 1-bit  

Technology CCD Sensor 

ADF Capacity 

1. 100 sheets (A4/Letter, 70 g/m2 or 18 lb.) 

2. 30 Business Cards 

3. 5 Plastic Cards 

4. Plastic Card, maximum thickness under 1.2 mm. 

Note: Maximum ADF capacity varies, depending upon paper 

weight. 

ADF Scanning Speed 

30 ppm/60 ipm (200 dpi, Color mode, Letter-sized Portrait) 

40 ppm/80 ipm (300 dpi, Grayscale mode, Letter Portrait) 

40 ppm/80 ipm (300 dpi, Black & White mode, Letter Portrait) 

Note: Results may vary depending upon your scanning 

application, computer processor and system memory. 

Scan Area 

(W x L) 

Maximum 216 x 356 mm (or 8.5” x 14”) 

Minimum 13.2 x 13.2 mm (or 0.52” x 0.52”) 

Acceptable Paper Sizes 

(W x L) 

Maximum 244 x 356 mm (or 9.6” x 14”) 

Minimum 50.8 x 50.8 mm (or 2” x 2”) 

Acceptable Paper Weight 

for ADF 

50 to 105 g/m2 (or 14 to 28 lb.)  

 

Power Adapter DC 24V, 1.25 A 

Power Consumption 

Operation: < 24 W 

Idle: < 4.5 W 

Standby (sleep mode):  < 0.5 W 

Off Mode:  < 0.3 W 

Interface USB 2.0 High Speed 

Operating Temperature 5°C to 40°C (41°F to 104°F) 

Relative Humidity 20% to 80% (non-condensing) 

Physical Dimensions 

(WxDxH) 
318.7 x 230.7 x 228.3 mm (12.55" x 9.08" x 8.99") 

Weight 2.7 Kgs (5.95 lb.) 

Protocols TWAIN Compliant  

EMI FCC Class B, CE 

                                                 
4  Hardware specifications may change at any time without prior notice. 
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APPENDIX B: 

CUSTOMER SERVICE AND 

WARRANTY 

Free Technical Support Through Email & Web 

Visit Ambir’s website at http://www.ambir.com for online access to 

technical support information including: installation guides, FAQs, 

troubleshooting tips, and driver downloads. Contact email addresses and a 

chat feature are also available online for your convenience in reaching us 

should you need further assistance. 

To avoid delays, please have the following information available before 

calling: 

 Scanner name and model number 

 Scanner serial number (Located at the rear of the scanner) 

 Scanner CD version and part number 

 A detailed description of the problem 

 Your current operating system 

 Name of software package(s), version or release number and 

manufacturer of the software 

 Other USB devices installed 

 
 

Technical Support by Telephone 

Support is available from 7:00 a.m. – 7:00 p.m. Central Time Monday-Friday 

by dialing (630) 530-5400 or (800) 915-9930, option 3. For all Ambir scanners 

you can speak directly to a technical support representative or leave a 

message for a call back. You will be connected to a highly trained, friendly 

and professional support agent who will work with you to resolve your issue. 

For expediency when you call please be in front of your system with your 

software and documentation handy for troubleshooting. 

*We will make every effort to respond to telephone support calls within one 

(1) business day. However, we strongly suggest that you make initial contact 

via email with an explanation of the problem you are experiencing and a 

call-back number should we need to speak to you directly. 
 

 

 

 

http://www.ambir.com/
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Product Warranty Information   

Statement of Limited Warranty for the United States, Canada and European 

Economic Community: 

 

Products – Ambir ImageScan Pro™ 940u 

Warranty Period – 1 year   

*Contact your place of purchase for warranty service information 

 

Warranty for Products 

Ambir Technology warrants our products against defects in materials and 

workmanship to the original purchaser for a period of one (1) year from the 

date of the original purchase. This warranty is limited to repair or 

replacement of the product, and the remedy provided to the purchaser for 

warranty service is the sole discretion of Ambir Technology. 

 

Extent of Warranty 

Any use of the product for a purpose in which it is not intended, and/or 

purchaser modifications, alterations, and/or repairs to the product, will 

constitute misuse and are not subject to the warranty. The warranty does 

not cover the repair or exchange of a product resulting from accident, 

unsuitable physical or operating environment, or failure caused by a 

product for which the Ambir is not responsible.  

 

Items Not Covered by the Warranty 

Host computer operating systems, application programs or hardware 

configurations are not covered. 

 

For customer service or further warranty information please email or call 

Ambir directly. Please provide product model name and number, place 

and date of purchase, your name, daytime telephone number and a 

description of the difficulty you are experiencing. You will normally receive a 

written email response or call-back within one (1) business day. 
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Ambir Technology 

918 N. Oak Lawn Ave. 

Elmhurst, IL 60126 USA 

Toll Free: (800) 915-9930 

Main Number: (630) 530-5400 

Technical Support: (630) 530-5400 option 3 

www.ambir.com 

 

FCC Radio Frequency Statement 

This equipment has been tested and found to comply with the limits for a 

Class B digital device, pursuant to part 15 of the FCC rules. These limits are 

designed to provide reasonable protection against harmful interference in a 

residential installation. 

This equipment generates, uses and can radiate radio frequency energy 

and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there is no 

guarantee that interference will not occur in a particular television 

reception (which can be determined by turning the equipment off and on), 

the user is encouraged to try to correct the interference by one or more of 

the following measures: 

 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment to an outlet on a circuit different from that 

which the receiver is connected. 

 Shielded interconnect cables and shielded power cord which are 

supplied with this equipment must be employed with this equipment 

to ensure compliance with the pertinent RF emission limits governing 

this device. 

 Consult the dealer or an experienced radio/TV technician for help if 

the conditions persist. 

Changes or modifications not expressly approved by the manufacturer or 

authorized service center could void the user’s authority to operate this 

equipment. 

This device complies with Part 15 of the FCC Rules.  Operation is subject to 

the following two conditions: (1) this device may not cause harmful 

interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation. 
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